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1. Activation 

Activation using Windows  

Upon starting SHARPEN projects 3 professional for the first time, you 

will be prompted to activate the program. Proceed as follows:  

Install SHARPEN projects 3 professional as described by the installa-

tion instructions.    

Input your serial number. For the box version, this can be found on the 

accompanying booklet. If you have chosen to download the program, 

you will find the serial number in your customer account at 

www.franzis.de. 

 

Finally, click on the “Activate” button. The software has now been suc-

cessfully activated! 

 

Activation using Mac  

Upon starting SHARPEN projects 3 professional for the first time, you 

will be prompted to activate the program. Proceed as follows:  

Install SHARPEN projects 3 professional as described by the installa-

tion instructions.    

http://www.franzis.de/
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Input your serial number. For the box version, this can be found on the 

accompanying booklet. If you have chosen to download the program, you 

will find the serial number in your customer account at www.franzis.de. 

 

Finally, click on the “Activate” button. The software has now been suc-

cessfully activated!  

Note: SHARPEN projects 3 professional can be installed on up to 

two computers using the same serial number.   

A second serial number is not required. When installing the program on 

a second device, simply enter the serial number again and press “Acti-

vate”.   

 

http://www.franzis.de/
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2. New Features  

SHARPEN projects 3 professional offers many new features. Here is a 

summary of some of the most important developments: 

 

 New intelligent masking function: Enables automatic selec-

tive sharpening while protecting specific image areas: Skin 

tones, sky blue, smooth areas, details, shadows, midtones and 

lights. 

 

 Oversampling Mode for all sharpness modes: Oversampling 

mode "single" and "double" for finer and therefore more precise 

calculation of image sharpness. 

 

 Quality mode "Pro Infinity": Pro Infinity uses the maximum 

possible size (of the current image) for the calculation of the 

PSF function and thus increases the quality of the blur reduction 

to the maximum possible. 

 

 Contour mode for blur reduction: In addition to the bright-

ness mode, a contour mode is now offered for blur reduction. In 

addition, there is also a function for automatically analysing the 

image and automatically selecting the correct mode for un-

sharpness reduction. 

 

 10 additional preparatory presets 
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 New „colour filter“ module in selective drawing: 8 different 

colour filters (red, orange, yellow, green-yellow, green, cyan, 

blue, violet)  

 Add-ons in selective drawing: 

- Adjustable contrast and colour saturation of the composing-

pictures  

- Bool‘sche functions to combine masks  

- Multiple UnDo & ReDo of the paintbrush-tool  

- 18 new layer processing methods in HSV and HSL colour 

spectrums 

 

 Scaled saving of images: A new sub-module in image crop-

ping allows you to save images in a smaller size. This also in-

cludes around 30 templates for various platforms including Fa-

cebook, YouTube and Instagram as well as pixel-precise input 

of image formats. 

 

 Scaling of images when loading in the image preparation: 

from 10% to 900% in 6 quality levels 

 

 Select a font: Select one of the installed and compatible fonts 

according to your own personal preference. In addition to the 

font size, you now have the possibility to create an individual 

working space with your entire user interface displayed in the 

font of your choice. 

 
 Add-on to the scratch- and sensor-correction: 5 new quality 

modes which search for corresponding areas automatically. 
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 Additional external programs: up to 12 external programs 

with configurable names.  

 Extras in the RAW-module: 

- Exposure value (EV) 

- Brightness red, green, blue 

- Hue shift 

- Soft contrast 

- Soft details 

- Pastel colurs 

- Bleach Bypass 

- Polarising filter 

- Reduce stray light 

- Ageing 

 
 Notes in the Undo-Timeline 

 

 Image Preparation: The RAW to Camera Display adjustment 

converts the RAW image during loading so that it comes as 

close as possible to the preview of the camera and the file pre-

view. 

 



SHARPEN projects 3 professional – User manual 

 

9 

 

 The new 'EV Value' mode creates an exposure series corre-

sponding to the EV (Exposure Value) steps. 

 

New Automations:  

 Automatic File Save with or without cropping edits  

 Automatic File Save in maximum resolution   

 Automatic Grain Engine reset capabilities  

 File Save extensions added to the file name in batch-processing 

can now be optionally deactivated  

 Information dialogues display on/off  

 Automatic Denoise Optimisation on/off  

 

New RAW-Formats: 

 

 Apple iPhone 8(*), iPhone 8 plus, iPhone X 

 BlackMagic URSA Mini 4k, URSA Mini 4.6k, URSA Mini Pro 4.6k 

 Canon PowerShot A410, A480, A540, D10, ELPH 130 IS, ELPH 160 IS, 

SD750, SX100 IS,SX130 IS, SX160 IS, SX510 HS, SX10 IS, IXUS 

900Ti, PowerShot G1 X Mark III, G9 X Mark II, EOS 6D Mark II, EOS 

77D, EOS 200D, EOS 800D, EOS 2000D, EOS 4000D, EOS M6, EOS 

M100 

 Casio EX-ZR4100/5100 

 DJI Phantom4 Pro/Pro+, Zenmuse X5, Zenmuse X5R 

 Eyedeas E1 

 FujiFilm S6500fd, GFX 50S, GFX 50R, XF10, X100f, X-A3, X-A5, X-A10, 

X-A20, X-E3, X-H1, X-T3, X-T20, X-T100, DBP680 
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 GITUP GIT2P, G3 DUO (16:9 only) 

 Hasselblad H6D-100c, A6D-100c 

 Huawei P9 (EVA-L09/AL00), Honor6a, Honor9, Mate10 (BLA-L29) 

 Kodak PIXPRO, AZ901 

 Leica CL, M10, M10-D, M-10P, TL2 

 LG V20 (F800K), VS995 

 Nikon D850, D3500, D5600, D7500, Coolpix B700, Z6, Z7, P1000 

 Olympus E-PL9, E-M10 Mark III, TG-5 

 OnePlus One, A3303, A5000 

 Panasonic DMC-FZ45, DMC-FZ72, DC-FZ80/82, DC-G9 (std. res mode 

only), DC-GF10/GF90, DC-GH5, DC-GX9, DC-GX800/850/GF9, DMC-

LX1, DC-ZS70 (DC-TZ90/91/92, DC-T93), DC-TZ100/101/ZS100, DC-

TZ200/ZS200, LX100M2 

 PARROT Bebop 2, Bebop Drone 

 Pentax KP, K1- II 

 PhaseOne KP, K1- II 

 Samsung Galaxy Nexus, Galaxy S3, S6 (SM-G920F), S7, S7 Edge, S8 

(SM-G950U) 

 Sony A7R III, A7 III, A9, DSC-RX0, DSC-RX10IV, HX95, HX99, RX100-

VA, RX-100VI 

 Yi M1 

 YUNEEC CGO3, CGO3P 

 Xiaoyi YIAC3 (YI 4k) 
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3. Configuring the User Interface 

Optional font size for menus and titles 

In the main menu of the program you will find in View  Font size an 

option to customise the size of the letters in the menu as well as in the 

titles of the programm. 

 

The font size can be adjusted to the run time of the program.  

4K – monitors gives you the option to enlarge the font size for better 

readability of the menu. 

 

Select a font 

SHARPEN projects 3 professional offers you the opportunity to desig-

nate a suitable font of your preference. You will find a selection of the 

installed and compatible fonts in View Font, simply pick your favourite. 
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If you want to change the font back to standard select View  Font  

reset font. 
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4. Photos Done Quickly  

You can obtain a finished image in just 5 clicks SHARPEN projects 3 

professional: 

 

1. Load Images  

2. HDR Preparation 

3. Post-Processing   Preset Selection 

4. Click on "Set automatically" 

5. Select Image Segment and Save, that´s it! 

 

 

You can simply drag and drop your images or bracketing series onto the 

start screen. 
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This way you can reach your goal quickly - but you can also go the crea-

tive way with individual image adjustments or selective drawing: 

SHARPEN projects 3 professional offers both variants. 

 

At the top of the screen are the main menu as well as the menu bar. This 

menu bar contains the following functions (from left to right): 

 

 

o Image data browser     

 

o History viewer      

 

o Upload image      

 

o Open project      

 

o Batch processing      

 

 

Optionally, image data may can also simply be „dropped“ onto the screen 

by Drag & Drop. The image data is then uploaded automatically. 

 

 Ímage data browser 

For a better overview of your bracketing series you can use the 

exposure bracketing browser before uploading your bracketing 

series. 

Click on the corresponding symbol in the task bar. A preview 

window will open. Chose by „quell folder” your exposure brack-

eting browser folder. 
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SHARPEN projects 3 professional starts immediately with the calcula-

tion, fitting automatically the right images together as well as showing a 

preview image. If you go across the image with the mouse, the image will 

automatically enlarge itself. 

 

The file type-filter is practical here, since one often has jpg rows and 

RAW images together in one folder. But if you type in RAW in the file 
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type, only the RAW rows will be shown. You won´t have any doubles any 

more. 

At 100% the search for images is finished. 

From this point on you will be able to upload the desired bracketing se-

ries. Click on the desired row with a right mouse click and chose in the 

context menu “open as project”. 

 

 

SHARPEN projects 3 professional uploads the images of the desired 

row and just like the simple Drag &Drop of the images on the desktop we 

start now with Post-Processing. 
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5. The Work Area 

As soon as an image file was uploaded into the program, the work area 
will open. 
 

 
 
This area is divided into four main sections: 

 

A) Menu and toolbar (top) 

B) Presets: image suggestions for the photo (left) 

C) Image area (centre) 

D) Denoising and export mode (right) 

 

The areas A), B) und D) can be taken out of the interface and attached 

to a different area or dropped into a different display. 
 
In area a) simply click on the dotted line on the very left of the bar, 
then hold down the mouse button to pull. 
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The areas B) und D) can be dragged away from the above areas via 

clicking and holding down the mouse button. 

 

 
 

 
 

To reset the work area to its original state, choose in the menu view and 

then reset screen. 
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6. Menu bar 

6.1 File 

File → Start  

When you are finished with 

the editing of an image or you 

want to close the current 

image, simply click on Start 

(or Ctrg + N) to close. 

 

File → Upload Image  

To open an image click on 

upload image (or Ctrg + 

Shift + O) to find the edited 

images.  

 

File → Image Data Browser  

Here you can display all of the images in a folder. With one click on the switch 

“include all subdirectories”, you activate the recursive search for all the image data 

in the specified source folder. 

 

File → History Viewer  

Click here to receive an overview of your projects so that you can choose between 

them. If you want to open an image, just double click on it. 

 

File → Save Final Image  

When you are happy with the image and you want to save it, simply click on save 

final image (or Ctrg + S). 
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File → Open Final Image in External Program  

If you want to edit the current image in a different image editing program, you will 

not have to leave SHARPEN projects 3 professional. Simply click on open final 

image in external program. 

 

File → Create Exposure Bracketing  

If you want to have differently exposed photos to create for example a HDR image, 

you can easily create a bracketing series with SHARPEN projects 3 profession-

al. You can choose between two modes: "Gamma Correction" (normal) and "Ex-

posure Value" (EV value). 

 

File → Print Final Image  

Click here if you want to print the current image. The image will be automatically 

centralised and the print medium scaled to size. 

 

File → Final Image into Clipboard  

The current image will be copied into the clipboard. You can add the image to 

other programs as well. 

 

File → Projects  

If you have already started a project SHARPEN projects 3 professional and you 

want to continue to work on the project, open this file by clicking on projects… 

 

File → Exit  

Click on exit (or Ctrg + F4) to close SHARPEN projects 3 professional. 
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6.2 Edit 

 
 
Edit → RAW Processing  

If you want to edit a photo without any complications, click on RAW development 

to change for example colours or to distort the image (see 16. RAW processing). 

 

Edit → Post-Processing  

As soon as you have edited an image or removed the noise, you will find yourself 

in the post-processing mode. 

 

6.3 View 

 

View → EXIF Information Window  

Shows you (if available) all EXIF information of an image file e.g. place, camera 

type, exposure time and time. 

 

View → Histogram  

The histogram shows you compactly the information of exposure distribution 

in a photograph. That way you can quickly identify if a photo is over- or underex-

posed. 

 

View → Full Screen View On/Off  

If you feel like you are being distracted by the task bar, you can simply click on full 

screen view on/off to switch into full screen. 
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View → Interface Style… (dark grey)  

You can change the colour scheme of SHARPEN projects 3 professional by 

clicking on Inteface-Style. The currently used colour scheme will be displayed in 

brackets. 

 

View → Font  

Choose your individual font from all compatible and loaded fonts. SHARPEN 

projects 3 professional now displays the entire interface in the font you have 

selected. 

 

View → Font Size  

You can change the size of the font between small, standard and large. 
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View → Frame Colour: Grey Card  automatic  

When you click on frame colour: grey card → automatic, the program will take 

the average frame colour of your image and will use it as your frame. 

 

View → Restore Window Defaults  

Resets the current window back to its original size. 

 

6.4 Extras 

 

 

Extras → Batch Processing (Ctrl + B)  

The batch processing of SHARPEN projects 3 professional allows the automat-

ic processing of multiple images. 

 

Extras → Preparing Image  

Here you can determine in which folder projects, exposure bracketing/ photo 

series, final images and default settings will be saved. 
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Extras → Benchmark  

If you would like to test how quickly your PC can remove noise from your images, 

Benchmark is the function to choose. The programs will render five different 

images in real-time and provides you with an evaluation on a five-star scale.  

Here the text size can be scaled in 4 sizes. 

 

Extras → Settings (Ctrl + P)  

Here you will find the various configuration options adaptable to your unique pref-

erences offered in SHARPEN projects 3 professional  

 

Program: Program Location 

Here you can determine to which folder to save your projects, exposure bracket-

ing/ photo series, final images and default settings. 

 

Program: Language 

Here you can change the SHARPEN projects 3 professional  program language 

to either German, English or French 

 

Program: Accelerate GPU 

Here you can choose to either activate or deactivate graphic card computing 

speed acceleration. 

 

Program: Tooltips 

Hovering your cursor long enough over specific tools or menu options will prompt 

the display of a short text offering an explanation of the function or tool. This is 

called Tooltip. Tooltips can also be deactivated here if preferred. 
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Program: Progress Bar 

During of effects in SHARPEN projects 3 professional, processing will be dis-

played with the help of a progress bar. Here you can decide when and whether to 

display the progress bar. 

 

 

Program: Projects 

When selecting the compression level, you are deciding how much storage space 

will be allocated for each one of your projects. At the same time, you are also 

deciding on how quickly the storage is performed. A lower level saves the projects 

faster, a higher level reduces the amount of storage space available on your hard 

disc. 
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Program: Undo 

With the option “save undo steps in projects”, you can save all undo steps 

within the project file. The undo-steps will then be completely reproduced when 

the file is opened. This creates a significantly larger project file. Set the maximum 

number of undo steps (1, 5, 10, 20 or 50). If you do not wish to set a maximum, 

select “unlimited”.  

The minimum free disk space specifies the amount of free space on your hard 

drive that will not be taken up by saving undo steps. This ensures the proper func-

tioning of your operating software. By default, this is set to 10% of your hard disk 

capacity but can be increased or decreased accordingly. 

 

Export 

 

Externe Programme 

Here you can choose in which format SHARPEN projects 3 professional will 

export images to external programs. You can specify as well which programs 

should be used for external image editing. 

Navigate to the file in which the function is installed and select it. 

 

NEW: You can now store up to twelve external programs and configure their 

names. 
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Save Formats 
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Jpg 

Jpg or Jpeg is the most common and popular format for most cameras and image 

editing programs. Here you can control the quality as well as optimally compress 

the image. Compressed images with high quality look better but do require more 

storage space. 

Tif 

Here you can choose between different compression methods for your Tif files. 

Png 

Png is popular for its graphics and digital visualisation. Here you can choose 

between a number of compression methods. 

 

Automatic 

 

Automatic: Sharpness Settings 

Here you can activate or deactivate the automatic reset of the quality settings for 

sharpening, such as HD colour protection, a Pro mode or also the Sharpness 

colour dominance. You can also set Auto Reset to protect image areas when 

loading a new image. If you want to use image area protection in batch processing, 

disable this setting. 

 

Automatic: Post Processing 

Post-processing automatically sets the corn engine back to its original settings 

with every newly started project. To use a fixed corn value in batch processing, set 

this the program and then deactivate this option. 

 

Automatic: Security Questions and Additional Information 

Here you can choose whether or not to display security questions or additional 

information. 
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Automatic: Automatic Undo Points 

Creates an automatic Undo-Point before RAW development, sensor correction or 

selective drawing. This creates a definitive starting point after uploading the image. 

 

Automatic: Image Preparation 

Displays the image preparation window when images are exported over a Plug-in. 

 

Automatic: Image Saving 

Activate the option “always save in highest resolution” and the processed image 

will automatically be saved in full resolution, even if the preview mode is active. 

Activate the option “show crop window when saving” and the crop window will 

automatically be displayed before image saving. 
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Automatic: Batch Processing / Image Date browse 

Here you can activate the automatic loading with the last used directory when 

opening the image data browser. You also activate the automatic inclusion of 

subdirectories in the image data browser and batch processing.  

You can also prevent files from being overwritten by automatically adding the 

original file extension (e.g. jpg, tif,...) for the file name created in batch processing. 

 

Extras → Reset  

This returns the current user interface to its original size. 

 

Extras → Create Restore point (Shift + Z)  

If you would like to save your image in its current state and continue editing without 

initiating a file-save, simply select the option Create Restore Point or (Shift + Z). 

This allows you to return to the last saved state of your image at any time. 

 

Extras → Timeline (Ctrl + T)  

Click on the Timeline or (Ctrl + T) to display all saved Undo-Points. 

 

 

6.5 Addons 

 

Add-ons → Import Add-on  

With the help of Add-ons, you can now not only 

import Presets into SHARPEN projects 3 professional but also integrate new 

Post Processing Modules that gives your Presets with an entirely new look. 
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Add-ons → Remove Add-on  

This button lets you remove add-ons. 

 

Add-ons → Addon Information  

Here you are provided with a display of all information regarding currently active 

Add-ons 

 

6.6 Information 

 

 

Information → SHARPEN projects – Homepage  

Click here to navigate to the in SHARPEN projects 3 professional homepage.  

 

Information → Show Shortcuts…  

Here you will find all keyboard shortcuts available in SHARPEN projects 3 pro-

fessional. 
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Information → Supported RAW Formats …  

A list of all cameras whose RAW Files are able to be opened in in SHARPEN 

projects 3 professional. 

 

Information → Check For Updates …     

This checks online whether newer versions of the software are available for down-

load. 

 

Information → About SHARPEN projects (Shift + F1)  

Information about the current version, 3rd-Party Software and Credits from 

SHARPEN projects 3 professional. 
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7. Toolbar 

This area of the tool bar divides itself into two separate areas. The left 

tool bar shows the different control functions of the program while the 

right shows the image view functions. 

 

 

 
 
The functions (from left to right) of this toolbar are: 
 

 Startpage 

 

 History viewer 
 

 Save project 
 

 RAW processing 

 

 Post-processing 
 

 Save final image 

 

 Print final image 

 

 Transfers the current image to the selected application of 
the product family 
 

 Open final image in external program 
 

 Create exposure bracketing 

 

 Create restore point 

 

 Timeline 
 
    Compare View 
 

 Histogram 
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The functions of this toolbar (from left to right) are: 
 

 Real-time calculation mode 

 
When activated, all of the changes that you have made to the preset 

settings will be immediately applied to the image. If this option is deac-

tivated, then you will only see the outcome of your adjustments when you 

click the button “calculate afresh”:  

 

 Recalculate image 

 

 High-quality display 

 
Activate this option to see the preview image in high-resolution. If the 

preview is set at 100%, there will be no difference. If you zoom in on a 

section of the photo however, there is a noticeable difference in quality.    

 

 Border pixel display 

 
The border pixel display helps to reveal areas that tend towards maximal 

light and dark values that is to white and black. Dark border pixels are 

depicted by blue/purple and light pixels by orange/ yellow.  
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Depiction of border pixels in orange and purple tones.   

If you would want to brighten this image, you have to be careful of the 

orange border pixels: Light surfaces on the car and the walls should not 

become too white, in order to avoid losing detail. In technical terms, these 

patches are called “burned highlights”. The border pixel view helps to find 

these critical image areas. 

 

 Original resolution view 

 

 Zoom to monitor size 

 

 Additional functions:  

 

 Crop image data 
 

 Horizontal mirroring of the images 

 

 Vertical mirroring of the images 

 

 Rotate the image 90 degrees anti-clockwise 
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 Rotate the image 90 degrees clockwise 

8. Image Preparation 

Here you can precisely configure the program’s settings. For the first 

steps, please use the standard settings. These default settings can be 

restored with the arrow at the bottom left. Nothing can be irretrievably 

adjusted. 
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A) Scaling: When bracketed series are uploaded, the images can 

be scaled from 25% up to 900% using any one of 6 different 

available Scaling Processes. 

 

B) Colour space conversion: Advanced users can choose a col-

our space here - for all other users, it is recommended to not 

make any adjustments in order to avoid incorrect colour render-

ing later. SHARPEN pro-

jects 3 professional of-

fers several new colour 

spaces (D65). The stand-

ard illuminant D65 is rep-

resentative for a phase of 

natural daylight with the 

colour temperature of 

6500° Kelvin.  

 

C) White balance corrects colour casts that occur with shots taken 

in shooting environments such as warmly lit rooms. To start, 

leave this setting unchanged.    

 
D) With this regulator one can adjust the colour temperature 

when you´re already uploading. It is advised that you leave the 

setting on “default” and to regulate the colour temperature later 

in post-processing. 
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E) Optimisations: During loading the Adjustment: RAW to cam-

era display converts the RAW picture so that it’s almost the 

same as the camera preview as well as the file preview. The au-

tomatic brilliance optimisation for RAW files can be activated 

in image preparation under RAW options. Frequently it is with 

camera RAW formats that the image data will not use all tonal 

values that are available. The automatic brilliance optimisation 

compensates this with the uploaded RAW images by amplifying 

the tonal values so that a meaningful utilised histogram is creat-

ed for every camera RAW image. 
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9. Post-Processing 

As in the previous version, we start post-processing directly after loading 

the images. Here we select a preset on the left side and edit the result 

with the functions on the right side of the 

user interface. 

9.1 Presets 

 

Left side of the post-processing 

screen:  

Here you can choose between 26 different 

presets.   

At the beginning the preset "Original" is 

selected. By clicking on the thumbnails, 

the effects are calculated in real time and 

displayed in the center of the screen. 
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Image with „Sport photography“ preset 

 

All 26 SHARPEN projects 3 professional presets at a single glance. 

The bar “default settings” you can detach easily and adjust to the desired 

size. 

9.2 Magnifiying Glass and Comparison View 
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On the right-hand side (at the very top) in Post-processing you will find 

the 1:1 magnifying glass. The magnifying glass shows you the area under 

the mouse in a 1:1 pixel view. 

 

 

When clicking on the magnifying glass, the new compare window will 

appear. This compares your edited image and the original image. It sim-

ultaneously gives you the opportunity to examine the comparison through 

the magnifier display. 

 

 

To keep the magnifying glass on a specific point, press down on the “L“ 

key, while you move the mouse over the screen. 

.  
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Click into the image area of the magnifying glass, to change between the 

display modus “divided before/after comparison” and “direct before/after 

comparison”. 

To unlock the locked area, press the L button again.. 

 

9.3 Point of Interest 

Activated “Point of Interest” renders current edits only to a specially de-

fined area of the image. The effects will be applied in their full form, how-

ever only visible in the specified spots, the rest of the image will be left 

unaffected. This effect is intended for very large, high-resolution photos, 

e.g. panorama pictures.    

 

 

9.4 Adjust Sharpness 

The image sharpness sharpness 

area on the right side of the 

screen is divided into the follow-

ing categories:  
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 All Presets  

Select the "All Presets" category to display all of the available presets in 

the below drop-down menu, and to select a fitting option. Click „Set au-

tomatically“ to automatically select the optimal preset. 

 

Before and after comparison following automatic processing with the "All 

Presets" category 

 

 Blurring  

Select this category if your original image is blurry. The drop down list 

contains a variety of sub-categories to specifically adjust the shake 

corrector. Click „Set auto-

matically“ to automatically 

select the optimal shake 

preset.  
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Before and after comparison following automatic processing with the 

„Blurring“ category. 

 

 Haze & Fog  

If haze and fog interfere in your original image this function is the right 

choice. The drop down list contains a variety of sub-categories to specifi-

cally set the haze or fog 

reduction. Click „Set au-

tomatically“ to automati-

cally select the optimal 

haze/ fog preset.  

 

 

Before and after comparison following automatic processing with the 

"Haze & Fog" category 
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 General image sharpness   

If you aren't faced with a specific problem like haze & fog or shake, you 

can adjust the general image sharpness, the "General Image Sharpness" 

option is the way to go.   

Use the options found in the drop 

down menu to choose the criteria 

for how, and to what degree of 

intensity, the image should be 

sharpened.  Click „Set automatical-

ly“ to automatically select the optimal overall sharpness preset. 

 

Before and after comparison following automatic processing with the 

"General Image Sharpness" category 

 

 Portrait   

If you are working with a portrait needing a bit of sharpening, select this 

category. Further sharpness presets can be found in the drop down 

menu. Here you can choose the 

sharpness intensity. There is a 

„soft look“, for blurring effects and 

a black & white effect. Click „Set 

automatically“ to automatically 

select the optimal  portrait preset.  
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Before and after comparison following automatic processing with the "Por-

trait" category 

 

 Landschaft  

Select this catrgory if your photo is a 

landscape requiring sharpening. 

Select the intensity of the sharpening 

in the drop down menu. Additional 

there is also a „soft look“ for blurring 

effects like in the category portrait. 

Additional effects like an HDR look 

are also available. Click „Set automatically“ to automatically select the 

optimal  landscape preset.  

 

Before and after comparison following automatic processing with the 

"Landscape" category 
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 Artwork    

The “Artwork” category offers various 

sharpness, blur and editing effects. If 

your image doesn't fit any other cate-

gory, this is your jackpot! Give differ-

ent settings from the drop down menu 

a try. 

 

 

 

 

Before and after comparison following automatic processing with the "Art-

work" category. 

 

Automatic Processing: 

The “Set automatically” button automatically modifies the currently load-

ed image.  

 

The automatic processing analyses the existing image material and looks 

for suitable presets based on the selected category. 
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The photo will be processed immediately and the automatically adjusted 

result will be instantly displayed. 

 

Automatic sharpness before and after comparison 

 

We recommend to always use the automatic first, and then to modify the 

sharpness settings (see 9.2) as well as the photographic settings (see 

9.5) as desired. 

 

Sharpness Colour dominance: 

The sharpness colour space is a special feature of SHARPEN projects 

3 professional. It is used to specialise the image sharpening processes 

in a selectable colour space. 

 

 

- The front camera symbol is used to adjust the algorithms to 

the average colour of the motif. 
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- With the eye symbol, settings are used which correspond 

most closely to the colour perception of the human eye. 

- The following eight coloured buttons ensure that the sharp-

ness procedures treat the selected hue with increased ac-

curacy and thus produce a finer image sharpness. 

Oversampling: 

The oversampling level defines the number of calculation steps in which 

image sharpness is calculated. The more steps you select, the finer and 

more precise the gener-

ated image sharpness.  

Note: The calculation 

time increases accordingly with the number of steps. 

 

Protect image areas: 

In the drop-down menu, you can select 

one of 16 different presets to protect cer-

tain areas of the image when calculating 

sharpness. The presets are divided into 

"skin tones", "sky blue", "smooth areas", 

"details", "shadows", "mid-tones" and 

"lights". 

Example: For example, if the blue sky is 

grained by sharpening the image, simply 

select “Protect sky blue” to prevent sharp-

ening of the blue sky areas.  
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The eye symbol  next to the drop-down menu shows you the masking 

in the image. Light areas are sharpened more than dark ones. 
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With the slider "Smoothing" you can adjust how smooth the masking of 

the image sharpness will be. The symbols below determine the effect of 

the masking: 

 

 
Masking only affects the sharpness settings. The pho-

tographic settings affect the entire image. 

 

Masking affects both the sharpness settings and the 

photographic settings. 

 

Masking only affects the photographic settings. Sharp-

ness settings affect the entire image. 

 

Click on the arrow symbol  to reset the mask area. 
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Reduce blurring:  

You can choose be-

tween four different 

modes. The balanced 

mode is a compromise 

between calculation time and the quality of the blur reduction and there-

fore offers good and fast results. The Pro mode increases the quality 

and requires three to four times more calculation time than the balanced 

mode. The Pro+ mode increases the quality substantially and requires 

about ten times longer in calculation time than the balanced mode. The 

Pro Infinity mode increases the quality of the blur reduction to the max-

imum possible and can require significant calculation time. 

 

Use the correction slider to select the amount of shake correction. 

 
 

Use the second slider to select the radius of the shake. A high value 

corrects large-surface camera shake, but also requires additional 

calculation time. 

 
 

 

The higher you set the quality the more detailed blurs will be corrected 

and the more calculation time will be required. 

 

 
 

The fineness indicates whether the shake correction should focus more 

on the large or the fine areas. The higher you set this value, the finer the 

correction will be and the longer the calculation will take.  
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Camera shake correction increases image noise. The amplified noise 

can be counteracted with this control. 

 
 

 

HD colour protection:  

If you have objects in your image that are particularly different in colour 

from others, you can activate the HD colour protection and thus ensure 

that the colour and the colour edges are calculated specifically and pro-

duce a much better result image. 

HD colour protection is an extension of the camera shake correction 

process. Particular importance is attached to the exact preservation of 

the colours in the image. This function requires additional calculation 

time.  

 

Example: 

 

The colour drawing at the edge of the sign has become more realistic. 
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Blurring comparison view:  

With the Point of Spread Function (PSF) comparison view, you can com-

pare the distribution of blur of a single pixel in your original image and 

your sharpened result image. The larger the bright area in the left image, 

i.e. "before", the more blur was found in the image. Conversely, the 

smaller the area in the right image, i.e. "after", the better the blur correc-

tion worked. In the best case an almost single bright pixel should be visi-

ble in the middle of the display.  

 

 

Example: On the left side you can see a distribution from the bottom left 

to the top right around the central point. This means that there is a blurri-

ness in the direction of the top right. This could have possibly resulted for 

example from a camera shake in the top right direction. 

With the slider "Brightness/Contours" you can switch between the bright-

ness mode and the contour mode as basis for the calculation of the blur 

distribution.  

The info icon next to it starts the contour analysis of your image and sets 

the brightness mode or the contour mode for the blur reduction depend-
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ing on the result. You can change this setting later if you do not like the 

result of the automatic setting. 

 

If you click on Blurring comparison view, a new window opens in which 

you can directly compare the before and after sharpness. In the toolbar at 

the top, you can select different view modes to display the sharpness. 

 

Displays the original image on the left and the processed im-

age on the right. 

 

Displays the processed image on the left and the original im-

age on the right. 

 

Displays the same image section for the original image on the 

left and the processed image on the right respectively. 

 

Displays the same image section for the processed image on 

the left and the original image on the right respectively. 

 

Activates/ deactivates the preview. Click on the preview to shift 

the main view to the clicked section. 

 

Activates/ deactivates zoom view on the mouse cursor. 

 

Puts the zoomed view in centered mode. 

 

Puts the zoomed view in non-centered mode. 

 

Photographic settings: 

The photographic settings allow you to make additional image 

adjustments in the following areas:  
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 Haze and fog: Reduces the haze and fog in an image. The fur-

ther right you move the control, the higher reduction in haze/fog.  

Note: If you are working with 

Jpeg images, artefacts will be 

created that are already con-

tained in the Jpeg file. 

 Brilliance: The motive bril-

liance strengthens the 

depth effect in an image. 

 Brightness: Change the 

brightness of an image to fit 

your wishes. 

 Colour: Control the colour strength from a little bit of colour 

(control left) to a lot of colour (control right). 

 Structure: Change the design of the structure in the image. To 

smoothen the structure, move the control to the left, to strength-

en the structure move the control to the right. 

If you have an image with a lot of mist or fog, these settings can be taken 

over by the automatic in the category mist & fog. 

In the following image the meadow with the flowers is hardly distinguish-

able and even the colour is almost hidden completely away by the mist. 

After the editing in the photographic settings, this meadow is far easier to 

see and the colours come out better as well. 

 

Note: If you are not satisfied with the automatic setting, you can adjust 

the controls until you are satisfied with the result. 
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Before and after comparison of the automatic haze & fog corrector 
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10.  Granulation  

a) Natural grain 

In natural grain the different 

levels of photographic paper are 

simulated, which creates a 

natural irregularity.  

These following parameters are 

therefore at your disposal: 

 

 

- Form  

Choose here from six different 

variants. 

 

- ISO-Number 

The preset value conforms to the average „restless value“ on a naturally 

grey surface. 

 

- Size 

The maximum size of the simulated grain. 

 

 

- Masking 

Gives you the opportunity to calculate the granulation in all different types 

of daylight or alternatively in light, shade or shade and light. 
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A Click on the button creates a new random distribution of grain 

and therefore a whole new look. 

 

b) Fractal grain 

Fractal grain simulates a large-

scale irregularity, which is creat-

ed through the storing and dete-

rioration of photo material. For 

this, you have the following 

parameters at your disposal: 

 

- ISO-Number 

The preset value conforms to the average “restless value” of a naturally 

grey surface. 

 

- Quality 

Determines the accuracy of the calculation (number of iterations for the 

fractal algorithm) of the fractal granulation. 



SHARPEN projects 3 professional – User manual 

 

61 

In the granulation module there is no singular best setting, since the ideal 

grain size, form and quality is 100% dependant on the motif. Here you 

can try out different things and find new creative paths.  

  

A Click on the button creates a new random distribution of grain 

and grants your image a whole new look. 
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11.  Local Adjustments and Selective Drawing 

 

The highlight tool from SHARPEN projects 3 professional deserves 

very special attention. Firstly, this tool selectively edits chosen areas 

without complicated masks done by hand, like other photo editing pro-

grams. SHARPEN projects 3 professional includes a completely newly 

developed intelligent border recognition algorithm, that independently 

identifies borders, lines, differentiations and light differences in drawing 

mode. The boundaries of the area that the mouse skimmed over are 

saved as a mask. These easily and precisely set masks serve as the 

basis for eleven important image enhancements: „Correct red eye“, 

„Beauty“, „Shading“, „Illuminating“, 

“Intensifying Colour”, “Reduce Col-

our”, “Strengthen Details”, “Reduce 

Details“ and „Increase contrast“,...  

These masks can even be saved as a 

separate image file and used in other 

image processing programs. 

How it all works is probably easiest to 

explain with an example. Open the selective drawing window (post-

processing, finalise - bottom right). Our example is a single RAW file of a 

mountaineer. The picture’s colour details are already well edited. Now we 

want to make the rock a little darker without darkening the rest of the 

picture.  
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 Quickly finalise your image with Selective Drawing 

1. Select editing objective 

For this case, select “Shading”. Make sure that the selected mask func-

tion is activated and the green checkmark is showing.  

 

2. Activate drawing mode   

3. Activate filling mode   
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4. Run the mouse over the contours without clicking. You can de-

cide and correct the brush 

size afterwards. 

5. Now look at the mask display. The object where the borders 

were automatically recognised is now depicted. Click and hold, 

and then trace your mouse along the edges of your chosen ob-

ject until it is completely selected. Attention! In the blink of an 

eye we will see the effect as well as the overlying mask. 

 

 

6. Once fully selected, blend the mask out by moving the mask in-

tensity control to the left.   

 

 

7. You will now see only the effect, that is darker rocks - our objec-

tive was “Shading”. Now you can adjust the intensity of the ef-

fect by sliding the control towards the + or -, according to your 
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preferred strength. Done: the rocks are darker while the rest of 

the image remains untouched.  

 

8. Click on “Close”. You will be returned to post-processing and the 

selective change will be applied. 

 

 

 

 

9. Use your quickly made mask for a further effect. Go back to the 

selective drawing. Our selective mask has remained.  

10. Click on  and copy the mask to the clipboard. Switch the 

mask to “Sharpen” and use the  to paste the mask back 

again. Now you have sharpened just the rocks, and the other 

parts of the image were not influenced. 

On the right you can clearly see the darker rocks after the selective correc-

tion. The rest has the same tonal values as before. 
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11. Every selectively applied effect can be activated and deactivat-

ed with the green checkmarks.    

12. Borders have different intensities in every image. Presets nor-

mally do just fine, but sometimes it is necessary to adjust the 

contour and sharpness settings in order to reach perfect fine-

tuned results. 

 

 

13. Have you drawn outside of the lines, despite the border recogni-

tion? You can easily remove it with the eraser .     If you only 

want to remove a small section, use the eraser with limitation. 

When set to 50%, you can only remove 50% of the mask, re-

gardless of how much you erase. The limited drawing mode 

works in the same way, and only draws at a certain opacity. 

14. If you want to mask the entire image except for a small object, it 

is a good idea to mask only the small object and then reverse 

the mask by clicking on the  

 

Pro Tip:  You have two filling modes to choose from when you want to fill 

a mask. When do you use which mask? We used the normal fill mode 

 as in our example for a large surface, which is also preferred for 

water and sky areas 

Ray filling mode   is very precise and favoured for smaller objects, 

geometric forms or subjects with straight lines, like in our example here. 
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With ray filling mode you can mask just the walls of the skyscraper while 

the window surfaces are not selected.    

 

Functions and Possibilities in Selective Drawing 

- Optional Mask Colours 

Designate a colour for the presentation of the mask as well as the brush 

one of the ready-made colours.  

 

The display will be immediately adjusted to your desired colour. 

 

- Selective Drawing – Creating Masks 

Masks can also be created from a colour or brightness. 
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With the button (1) you activate the “Create Mask” modus. You will find 

yourself in the standard mode “Create Mask out of Colour”(2). If you want 

to create the mask from a brightness, chose the (3) button. 

The tolerance controller decides, how sharp (smaller value) or soft 

(higher value) the created mask will be. 

While you are in the “create mask” mode your mouse pointer will turn into 

a pipette. The colour or brightness in which your mouse pointer is set, will 

determine the type of mask being created. 

 

In the above example we can see how a red mask has been created for 

the sky. 

Tip: If you want to combine several colours in one mask, simply click on 

the desired colours after each other with the pipette on the screen. The 

current colour will with every click be added to the current mask. 

 

- Selective Drawing – Smoothing Brush 

The smoothing brush (1) gives you the opportunity to draw selective 

areas of the mask softly.  
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To draw an area even softer, just go over the same area with the smooth-

ing brush several times. 

 

- Global Mask Functions 

In the area of global mask functions you will find several special modes 

that you can use directly.  
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1. Reducing the entire mask outline 

becomes    

 

1.  Increasing the entire mask outline 

 becomes   

 

2.  Soft-focus effect on the entire mask 

becomes    

 

With global functions there are two buttons – the left button fulfils the 

function with a lower effect while the one on the right with a bigger effect. 
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- Multiple Undo and Redo for Brush Functions 

Click once or several times on the left arrow to go back one or several 

brush strokes or on the right arrow to jump forward one or several brush 

strokes. 

 

- Reset the Function of a Mask 

Every mask can without any influence on the other masks be reset to its 

original state. You simply click on the waste paper button (1). 

 

After clicking on the button a security query will follow, so that no im-

portant work can be lost by accident.  

 

- Colour Filter in Selective Drawing 

Besides of the effect masks you will 

find the field of colour filter masks. 

Click on the dropdown menu to 

choose one of the following filter: 

red, orange, yellow, yellow-green, 

green, cyan, blue and violet. 
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- Adaptation of automatic masks in the “Distortion correc-

tion” section of the RAW module 

Selective drawing works directly with the RAW module. This includes the 

“Distortion correction” that is part of the RAW module and that is applied 

completely automatically on several drawn masks. 

 

In the example we have an image in which the sky has already been 

masked. When we now continue by correcting the horizon within the 

image in the RAW module, the drawn mask will automatically adjust itself 

to the “Distortioncorrection”. 
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Beauty: 

This is how you smooth the skin of people in three easy steps. 

 

Step 1:  

Choose the mask “beauty” in selective drawing mode. 

 

 

Step 2: Choose through repeated clicking the area that should be edited. 

Don´t worry the yellow colour marking will disappear later and only serves 

as visualising the process. 
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Step 3:  Click on “close” to apply the chosen mask on the photo. 
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Correct red eye: 

This is how you remove red eyes in three easy steps. 

 

Step 1:  

Choose the mask “correct red eyes” in selective drawing mode. 
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Step 2: Choose the red pupils with the paintbrush. 

 

 

Step 3:  Click on “close” to apply the chosen mask on the photo. 
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12.  Composing Mode 

In the Composing mode of selective 

drawing you have the ability to build 

up to 4 layers of images into your 

current motif. 

To switch into the composing modus, 

click on the “composing” button (1). 

From the list of choices (2) you can 

choose with which composing level 

you want to work with. 

With the button (3) you activate the 

currently chosen mask. Now you can 

through a click on the frame of the 

image (4) upload any image you 

wish to create the next level. 

You can use RAW images, Jpg, Tiff 

as well as several other image for-

mats. 

Underneath the display screen you 

will find the parameter area that be-

gins with two buttons with the follow-

ing functions: 

 

(5) Multiple application 

Reduce the size of the image on a 

different level than the one that 

you´re currently working on. With this 

option you will be able to stretch the 
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reduced image outwards (up, down, left, right). 

 

(6) Determine the width-to-height ratio 

This function allows you to determine the width-to-height ratio of the 

uploaded levels, since the width-to-height ratio in an uploaded image 

level can differentiate from the current image you´re working on. This 

preserves the proportion of the levels. 

 (7) Horizontal Reflection 

This function allows the image layer to be mirrored horizontally. This 

enables more precise adjustment to the current image without having to 

make changes to the image layer.  

(8) Vertical Reflection 

This function allows the image layer to be mirrored vertically. This ena-

bles more precise adjustment to the current image without having to 

make changes to the image layer.  

 (9) The Control-parameter 

Width-to-height ratio: If the width-to-height ratio isn´t fixed with the 

button (6), you will be able to change the width-to-height ratio however 

you desire. 

Zoom: Choose the size of that image level by zooming in or out 

Shifting horizontally: Move the image level to the left or right 

Shifting vertically: Move the image of that level up or down. 

 

Exposure: Since it can often happen that the exposure of your current 

image does not match the exposure of any layer image, you can easily 

adjust the exposure of the layer image here and darken or brighten it as 

desired. 
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NEW: Using the Contrast and Colour sliders, you can further adjust your 

compounding image next to the exposure, so that it blends in even better 

with your original image and the overall image looks even more realistic. 

 

A night image with a not very fascinating night sky... 

 

....you can change within a minute with the help of composing into 

an eyecatcher. 
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13.  Removal of Scratch and Sensor Errors 

 

Micro-contrast enhancement used in photography unfortunately shows 

every unwanted sensor imperfection that every photographer, despite 

internal camera sensor cleaning, knows and dreads. Don’t stress - just 

eliminate them! With the easy to apply correction function from SHARP-

EN projects 3 professional, it can even be fun.  

Pro Tipp: This intelligent correction doesn’t only remove sensor spots, 

but other disturbing things too - a deserted beach has never been so 

easy to produce. 

Lightly mark defects in your motif – the program will automatically substi-

tute these areas with other appropriate parts of the image. 

 

The sensor spots are circled in red 
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Here’s how to go about correcting: 

Select the brush tool under (6) and click on the point of the image that 

you would like to correct. A circle will appear beside it that will serve as a 

source.  

Move this circle to a place on the image 

that can act as a source for the first mark-

ing. The selected area will then be im-

proved based on the source.  

 

Prior to this, you can reveal sensor spots, 

which will appear as a bright patch in the 

image, with (1).  

 

(2) Allows you to expose or hide the fixed 

areas. The corrections are still active, 

even if they have been blended in.  Hiding 

is solely to enable a before and after comparison.  

You can select multiple areas to correct by simply clicking on the brush 

symbol (6) and adding another point.   

 

The button marked (3) can blend the targeted corrections in and out, 

which also controls clarity.  

 

NEW: Under the quality (10) tab, a dropdown menu including five new 

quality modes allowing you to automatically search for corresponding 

areas will open. With the different quality levels you can scale how the 

automatic search proceeds. 
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Note: This search quality is used for all of the following search area set-

tings. 

 

 

(5) Deletes the added corrections.   

 

The section marked (7) controls the size of the area that is to be correct-

ed.   

 

You also have the option to automatically search for the best source area 

for the improvement. Click on the (8) button.   

 

Button (4) calculates the appropriate correction spots for all of the points 

automatically set using (8).   

All currently selected corrections can be deleted with the (9) button.   

 



SHARPEN projects 3 professional – User manual 

 

83 

The sensor spot corrector marks all of the patches and determines a 

source within the image that can be used as a substi-

tute.

 

Successful sensor spot correction. 
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14.  Workflow 

 Edit final image further in an external program 

SHARPEN projects 3 professional offers interaction with external 

programs. This way you can take a successful result to another photo 

editing program and continue there. 

 

 Open in other projects programs 

Click on the “Projects” symbol in the toolbar to open the image in a differ-

ent program from the projects series. Use the drop-down menu beside 

the symbol to choose one of the programs that you already have installed 

on your computer.  

 

 

 Open in other photo-editing programs 

To directly open the image in another 

photo editing program, such as Ado-

be Photoshop, click on the corre-

sponding button in the symbol bar.  

If necessary, go through the settings 

to show the path to the program. 

Click on “Extras” in the menu and 

select “Settings” in the drop-down 

menu: 
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Next, click on the “Export” tab. You can enter the name of a photo editing 

program here, and save it for later as well.  

With the exception of Adobe, you have the option to rename the external 

editors. The name you assign will be displayed in the Quick Export menu 

in the toolbar of the main screen. 

 

 



SHARPEN projects 3 professional – User manual 

 

86 

 Work with a Timeline and Restore Points 

This option can be found in the symbol bar at the top edge of the screen: 

 

“Create Restore Point” saves a virtual snapshot of the current settings. 

You can now always return to this stage of your editing. You can save as 

many editing restore points as you like. The timeline displays the restore 

points and makes it possible to call up any phase of the editing process 

with just a single click:   

 

 

 

This function is especially useful when, for example, you are satisfied 

with an image, yet want to continue trying out different settings and ef-

fects. Simply set a restore point and carry on editing your picture. If you 

want to go back, simply click on your restore point in the timeline.    

If you click on  you can add your own note as a heading. 
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15.  Selecting and Saving Sections of Im-

ages   

To save a final image, click on the button in the toolbar, go 

through the file menu or use the corresponding keyboard shortcut 

(Ctrl + S).   

 

 Cropping and captions 

As soon as you have initiated a file save, the cropping and caption win-

dow will open. If you would not like to crop or add a caption to your im-

age, click continue.  

 

At the top are several practical aids for perfect image composition and 

cropping.   

You can set the aspect ratio and activate guidelines like the rule of thirds, 

the golden section or the golden spiral.  The new photo centre display is 

also quite practical which you can access by simply clicking on 

this button. 
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The centre of the window shows your final image. Fix the area to be 

saved by adjusting the corners and borders of the photo.   

At the bottom is an option to enter a caption. You can determine the size, 

position and background for the text. 

The size of the text will be automatically coordinated to the final cropping. 

 You can either crop by hand or 

use one of the 71 provided 

formats.    

 

Please note: If you choose 

the cropping ratio 13 x 18, 

for example, the final image 

will not be saved as 13 x 18 

cm, rather as a ratio of 13 to 

18.    

 

 

You will also find the "Scale and Save" button at the bottom. With this 

option you can choose between 30 different templates for various online 

platforms such as Facebook, Instagram, YouTube, etc. or simply specify 

your own scaling values (scaling in percent and resolution in pixels). 

 

As soon as the image has 

been cropped and cap-

tioned, confirm the save and 

the following window will 



SHARPEN projects 3 professional – User manual 

 

89 

prompt you to select a file format and name your file. 

16.  RAW Processing 

You can upload and edit 

RAW image data with the 

integrated RAW mode. 

Numerous tools are availa-

ble to you here, such as 

denoising/sharpen, expo-

sure, colour and detail as 

well as powerful distortion 

capabilities.   

  

 In this RAW mode changes 

that are made will be trans-

ferred onto the entire bracketing series, so that you only have to put in the 

settings once. 

Resetting the category: 

Every category can through a click on the reset-button (bottom left) be 

reset to its original state without influencing the settings of the other cate-

gories. 
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Overview of the most important RAW functions:   

White balance: Here you can regulate the colour temperature. Use the 

pipette to select a white balancing colour directly from the image.    

Denoising/ Sharpness: This feature regulates the image’s noise and 

sharpness. Control the quality and different types of noise such as colour 

noise, banding or hot pixels.   

Colour balance/ white balance: Here it’s all about colour and 

black/white correction. Modify the general colour mood and neutralise 

white and black - the icing on the cake for professional colour correction.    

Exposure: Here you again influence the shadows, highlights, contrast 

and brightness of the original images. Dynamic Brightness adjusts the 

brightness individually to the image content. What's new is that you can 

set an exposure value from -10EV to +10EV and use this value to fine-

tune the exposure by -1EV to +1EV in addition. You can also change the 

soft contrast in the image. This reverses the brightness differences in the 

image on a large scale. 
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Struktur: Fine-tune clarity and micro-details with lights, shadows and 

midtones.    

Colour: These colour settings are 

about luminosity in shadows and lights. 

Here you can also counteract unloved 

chromatic aberrations.  

A lens curvature is calculated back-

wards on the selected colour channel. 

You have the choice between: "Diffrac-

tion Green", "Diffraction Blue" and "Dif-

fraction Red".  

In these colour settings, it is about lumi-

nosity in shadows and lights. Here you 

can also counteract unloved chromatic 

aberrations.  

The "colour effects" contain the follow-

ing functions: Pastel colours, bleach 

bypass and colour angle. Pastel colours 

tend to be light colours, so amplification 

will brighten the image a bit. The colour 

angle rotates the image through the 

entire colour circle. 

Under "Colour Channels" you can 

change the brightness of the red, green 

or blue components. 

 

Palate: Adjust the saturation of individual colours.   
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Distortion: Take a closer look. These mighty tools can straighten out the 

horizon, correct camera angles and lens errors. Use “Autofit” to automati-

cally trim any awkward borders.    

 

The reference grid can be adapted in the distance between the grids as 

well as in its transparency. This is how you will always have the maximum 

overview when you are correcting your settings. 

 

 

 

Lens correction: Corrects the edge light loss that occurs with some 

lenses. 

Peripheral light: Corrects the curvature of the lens. 

Horizon: Corrects the horizon by rotating the image. 

Vertical: Tilt the image left or right for vertical perspective correction. 

Horizontal: Tilt the image left or right for horizontal perspective correc-

tion. 

Zoom: Zooming the image avoids empty areas that may occur during 

distortion correction. 
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Trapezoid left/ right: The vertical trapezoid correction pulls the image 

either at the left or right edge of the image and corrects the perspective. 

Trapezoid top/ bottom: Horizontal trapezoid equalization draws the 

image either at the top or bottom of the image and corrects the perspec-

tive. 

Stretch left/right: With this parameter you can stretch the image into the 

width, starting from the left or right edge of the image. 

Stretch top/ bottom: With this parameter you can stretch the image 

upwards, starting from the top or bottom edge. 

Aspect: Change the aspect ratio of your image files. 

Shift L-R: Shift the image files to the left or right. 

Shift U-D: Shift the image data up or down. 

 

Categorie FX: 

This category contains some special effects, like a haze & fog correction, 

the rescue of highlights, sepia and film grain as well as different bright-

ness gradients. 

New effects: 

- Reduce stray light 

- Polarising filter 

- Ageing (Reduce optical age) 

Pro Tip: 

When you take a landscape shot, shift the controller to “Gradient top” to 

a dark tone and create in that way a neutral thick (ND) – process filter. 
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General:  

Activate the “360° panorama mode” to optimise matching edges of imag-

es in a panorama series. Save your settings as a camera profile to save 

time in the future. This can be reset at any time.    

If you have conducted the settings in RAW mode, click on “apply”. 

If you save your settings in the camera profile, you will save a lot of time 

for future photographs. The settings can be reversed at any time 

 

 

Zoom and Brightness 

At the top right are the sliders for zoom and brightness of the picture 

display.  

Note: With the brightness setting of the picture display, you do not 

change the brightness of your picture, but only the display, for example to 

be able to recognize the effect of a picture noise in darker areas. 

 

Histogram 

The histogram is located below the sliders.  

RGB: Here the RGB values of the pixel are displayed below the mouse 

pointer. 
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HSL: Displays the HSL values of the pixel below the mouse pointer. 

Note: HSL stands for Hue (colour angle), Saturation (colour saturation) 

and Lightness (brightness). 
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17.  Batch Processing 

SHARPEN projects 3 professional´s batch processing allows for au-

tomatic processing of multiple bracketing series. The function can be 

found in the drop-down menu for “Extras” in the menu bar.  

First, choose the source folder where the individual images (HDR from 

one exposure) and/or the bracketing series are located. The files can 

also be mixed, since the system will automatically recognise and sort the 

bracketing series vs single shots.   

Note: Remember that looking through folders with several subfolders can 

require a lot of time. This is why selecting “C:\“ is not recommended. 

 

Source file: Here you define where the result images of the batch pro-

cessing are to be saved. Simply select the corresponding folder using the 

"Select destination folder (. . .)" button or enter the destination folder 

directly into the text field. 

Results: You can choose from nine formats for the storage format of the 

result images from batch processing. You can choose between .jpg, .tif 

and .png. JPG images are always saved uncompressed and lossless in 

the highest possible quality and TIF files. 

 

Processing settings 

In the processing settings, select the default setting for image generation. 

These are valid for all batch exposure series. 

- Image preparation: Allows you to change all RAW processing 

and image orientation settings of the current batch processing.  

- Image sharpness: Select the default setting for the image 

sharpness from chapter 9.4. 
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- Post-Processing: The preset default setting contains all pre-

sets from the post processing area. 

 

Note: On a Macintosh computer, this dialog opens before the batch win-

dow due to the system. 

Click on the arrow at the bottom left to reset the batch processing to the 

default values. 
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18.  Plug-in Installation 

SHARPEN projects 3 professional can also be used as a plug-in for 

Adobe® Photoshop. Newer versions of Photoshop are automatically 

detected by SHARPEN projects 3 professional during installation and 

the plug-ins are installed in the respective plug-in folder. Older versions 

of Photoshop might require manual installation. 

If you have purchased a download or lost your CD, you can add the Plug-

Ins later from www.projects-software.de/plugins.  

 

18.1 Using Photoshop Plug-ins - Windows 

The following window will appear when installing SHARPEN projects 3 

professional: 
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Select the version of Photoshop where you would like to install the 

SHARPEN projects 3 professional plug-in. Click on “next” and follow 

the instructions from the installation assistant. The plug-ins will then be 

automatically installed.  

  

Tip: With older window systems it can happen that the Plug-ins won´t be 

installed automatically. In this case just copy the desired Plug-In into the 

right folder of your current Photoshop version (as shown in the photo 

found in the “Plug-ins” folder”). If you have an older version of Photoshop, 

copy the smallest plug-in. 

Example: Users of Photoshop CS6 copy the Plug-In for Photoshop CS6 

and not for example Photoshop CC 2014. In this case CC 2017. The 

relevant Plug-in is on the CD in “Plugins”. 

The folder you will find under C:\Programme\Adobe\Adobe Pho-

toshop CC 2017\Plug-ins  

 

You can also carry out the installations of the Plug-ins at a later point in 

time. Please install Photoshop first then the projects-Plug-ins! After 

the installation of the Plug-ins please open Photoshop once more. 

 

In Photoshop you will find under the menu point “Filter” the entry Fran-

zis. Here all of the Plug-ins of the projects-series are listed. 
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Click on SHARPEN projects 3 professional. The opened and edited 

image in Photoshop will now be opened in SHARPEN projects 3 pro-

fessional. 

 

Now the program is in the Photoshop Filter-Plug-in mode. You can as 

usual edit the image in SHARPEN projects 3 professional. Subse-

quently you can send the finished image over the control “Apply” back 

into the Photoshop-level. 
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With the control “cancel” you close the Filter-Plug-in without sending the 

changes in the image back to the Photoshop level. The editing done in 

SHARPEN projects 3 professional will be discarded. 

 

The projects program will then automatically close, a mechanism that is 

made mandatory by Adobe Photoshop. 

 

18.2 Using Photoshop Plug-ins - MAC OS X 

Plug-ins can be found on the start screen in the “Plug-ins” folder. Select 

the appropriate folder for your version of Photoshop (we chose Pho-

toshop CS6 for our example). Double click the .zip file to extract the plug-

ins. 

 

Next, drag & drop the unpacked plug-in SHARPENpro-

jects3ProfessionalFilter_PH6.plugin (PH7 in other photoshop ver-

sions) to the plug-in folder for your version of Photoshop, which is nor-

mally labeled as “plug-ins”. 

 



SHARPEN projects 3 professional – User manual 

 

102 

 

Start up your version of Photoshop, load an image and navigate to 

„Menu  Filter  Franzis  SHARPEN projects 3 professional “ 

 

One click will start the plug-in. The image will now be opened in SHARP-

EN projects 3 professional. 
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Now the program is in Photoshop Filter-Plug-in mode. You can edit the 

image as usual in SHARPEN projects 3 professional. 

 

Subsequently you can send the finished image over the control “apply” 

back into the Photoshop level, from where the image originally came. 

 

With the control “cancel” you close the Filter-Plug-in without sending the 

changes in the image back to the Photoshop level. The editing done in 

SHARPEN projects 3 professional will be discarded. 

 

The projects program will then automatically close, a mechanism that is 

made mandatory by Adobe Photoshop. 

 

18.3 Using Adobe Lightroom Plug-ins - Windows 

Start the installation program and verify that the component chosen is 

“Lightroom Plugin”. 

 

If you do not have a CD, download the Plug-in from www.projects-

software.de/plugins .  

Then open the Lightroom version. Start Lightroom and follow the direc-

tions “file  plugin manager” to verify that the Plug-in is activated. 
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If this should not be the case, then you have the option to click on “add” 

in the additional module manager to then manually install the Lightroom 

Plug-in. 

 

To achieve this go to the folder Lightroom Plug-in to find SHARPENPro-

jectsPro.lrplugin. 
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As soon as you find yourself in the folder SHARPENrojectsPro.lrplugin, 

click on “select folder” to install the Lightroom Plug-in. 

 

Lightroom: SHARPEN projects 3 professional: Installed and executed. 

 

Highlight the exposure series in your Lightroom library. 

 

Click with the right mouse button directly onto the highlighted images and 

choose the entry “Export  Export to SHARPEN projects 3 profes-

sional”. 
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Or: Choose “File  with the target export  Export to SHARPEN 

projects 3 professional”. 
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18.4 Using Adobe Lightroom Plug-ins - MAC OS X 

For Adobe Lightroom, the plug-in will not be automatically installed. Con-

tinue as follows: 

Install SHARPEN projects 3 professional to the program link of your 

Mac. 

Copy the plug-in .zip file from the “Lightroom Plug-in” folder on your CD-

ROM. „Lightroom Plugin“. We recommend the folder where also your 

presets are stored: 
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„Users/username/ SHARPEN projects 3 professional“. 

Start Lightroom und navigate to „File  Plug-In Manager“. 

 

Click the „Add“ button in the Lightroom Plug-In Manager. 
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Navigate to the appropriate Lightroom plug-in for SHARPEN projects 3 

professional that you just added to your MAC. 

 

Sometimes it can be necessary to close Lightroom and then to restart. 

Afterwards, the plug-in will be installed and activated. 
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Now the Plug-in should be installed and executed.  

There are more ways to export your image from Lightroom to SHARPEN 

projects 3 professional.  

„File  Export with Preset  Export to  SHARPEN projects 3 pro-

fessional“. 



SHARPEN projects 3 professional – User manual 

 

112 
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OR:  

 

Right-click on the image directly in Lightroom and select „Export  Ex-

port to SHARPEN projects 3 professional“. 
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19.  Keyboard Shortcuts 

Overview of the integrated Keyboard shortcuts 

In the main menu in the area of information you will find an overview of 

all available keyboard shortcuts.  

 

Click on this item to open the overview: 

 

In the overview you will be able to scroll through the different areas, 

where you can take shortcuts. 
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General: 

Windows Apple 

Ctrl N  cmd N New project 

Ctrl Shift O  cmd Shift O  Upload single image 

Ctrl S  cmd S  Save result image 

Ctrl D  cmd D  Print result image 

Shift Z  Shift Z  Create restore point 

Ctrl T  cmd T  Open timeline 

Ctrl F4 cmd F4 Leave program 

F4 F4 Open RAW mode 

F7 F7 Show post-processing view 

Ctrl P  cmd P  Open settings 

Ctrl B  cmd B  Open batch processing 

@  Show product homepage 

Shift F1 Shift F1 Open about window 

Ctrl E  cmd E  Show exif information 

Ctrl H  cmd H Show/ hide histogram 

Ctrl F  cmd F Open/ close full screen 

 

 

Image Functions: 

Windows Apple 

Ctrl + cmd + Zoom in 

Ctrl - cmd - Zoom out 

Ctrl 0 cmd 0 Adjust image to view 

Ctrl 1 cmd 0 Zoom to 100% 

R  R Real-time mode on/off 

L  L Lock radar window (lock) 
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RAW Developing: 

Windows Apple 

Ctrl + cmd + Zoom in  

Ctrl - cmd + Zoom out 

 

 

Progress Browser: 

Windows Apple 

Image upwards  Image upwards A page back 

Image downwards  Image downwards A page forward 

Pos1 key Pos1 key To the beginning 

End key  End key To the end 

Cursor left  Cursor left Last entry 

Cursor right Cursor right  Next entry 

 

 

Selective Drawing: 

Windows Apple 

Ctrl + Ctrl + Zoom in 

Ctrl - Ctrl - Zoom out 

Ctrl 0 cmd 0 100% View/ switch adjustments 

A  A Activate pencil  

Shift A  Shift A  Activate pencil  with limit 

S S Activate rubber  

Shift S  Shift S  Activate rubber with limit 

W W Activate soft focus brush  

E  E Activate image mask creator 

D  D Activate fill mode 

F  F Activate brush fill mode 

R  R Activate brush streak mode 
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1 1 Reduce brush size 

2 2 Increase brush size 

3 3 Reduce opacity 

4 4 Increase opacity 

5 5 Soften outline recognition 

6 6 Sharpen outline recognition 

7 7 Reduce blur 

8 8 Increase blur 

Ctrl Z  cmd Z One step back 

M, Shift M  M, Shift M  Mask display on/off 

 

 

Scratch/ Sensor Spot Removal: 

Windows Apple 

Ctrl + cmd +  Zoom in 

Ctrl - cmd -  Zoom out 

 

Cursor left, Shift Cursor left, Ctrl Cursor left   Shift active correction region left 

Cursor right, Shift Cursor right, Ctrl Cursor right Shift active correction region right 

Cursor upwards, Shift Cursor upwards, Ctrl   Shift active correction region up- 

Cursor upwards   upwards 

Cursor downwards, Shift Cursor downwards  Shift active correction region down- 

Ctrl Cursor downwards   wards 

Image upwards  Image upwards  Select previous correction region 

Image downwards Image downwards  Select next correction region 

C  C  Activate all correction regions 

N  N  Set new correction region 

Delete key Delete key  Delete correction region 

+ +  Enlarge active correction region 
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- -  Minimize active correction region 

 

Image Cropping: 

Cursor left, Shift Cursor left, Ctrl Cursor left  Shift cropping region to the left 

Cursor right, Shift Cursor right, Ctrl Cursor  Shift cropping region to the right 

right  

Cursor upwards, Shift Curser upwards, Ctrl  Shift cropping region upwards 

Cursor upwards 

Cursor downwards, Shift Cursor downwards,   Shift cropping region downwards 

Ctrl Cursor downwards  
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20.  Integrated List of supported RAW Formats 

 

In the main menu in the area information you will find an integrated list of 

supporting camera RAW-formats sorted by manufacturer.  

 

If you chose this menu item a camera RAW-format window will open. 

 

In the top area of the window you will find a selection of choices, with 

which you will be able to filter the list for singular camera manufacturers. 

This way you will find your camera faster. 

To have constant access to the supporting camera RAW- formats via a 

separate window, you can use the function „open in browser“(window 

bottom left), which will show the list in a standard browser. You will also 

be able to print the supporting RAW-formats from there. 
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